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Overview 
Welcome to the next generation of ToolDesigner for Windows.  The ToolDesigner applications 
have been transformed into true Windows applications.  As a necessary part of this 
transformation, the user interface has been dramatically changed to adopt Windows-standard 
features and appearance while retaining the unique characteristics such as cursor strokes that 
makes the software so productive. 

 

ExpertCAD 3D 2009 
 
This document will serve as your guide to these major changes in the user interface including the 
new features and functions now possible.  Although major changes have been made, you will find 
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it very easy to adapt to this new version because wherever possible, Windows standards and 
industry conventions have been followed. 

 
Windows User Interface Overview 
This section describes the changes to the user interface.  The examples shown are typically for 
ExpertCAD and/or ExpertCAD 3D however all applications use the same user interface layout 
and usage. 
 
General Window Layout 

The same general layout of the window has been retained: 
• Windows menus along the top of the window. 
• Central graphics area for display of the drawing or NC cutter path. 
• Static icons along the right-hand side. 
• Pop-up menus. 
• A message area at the bottom of the screen for prompts and messages. 

 
Status Bar 

A Windows-style status bar has been added to the bottom of the window: 

 
This status bar replaces the old ‘headline’ in previous versions.  Clicking in any of the cells that 
report the current layer, units, etc. will cause a dialog or prompt to allow you to quickly change 
their status just as with the former headline. 
 
In the left-most cell of the status bar, the coordinates of the cursor will be shown & updated as 
you move the cursor around the drawing.  Holding down the ‘Shift’ key while moving the mouse 
will report precise coordinates of geometry nearby: 

 
 
Holding down the Ctrl key will provide an on-screen display the coordinates as a tool tip popup 
window: 

 
 
Display of the coordinates on-screen and in the status bar can be disabled in the User 
Preferences tab of the Tools/Options dialog. 
 
A progress meter is shown in the left-most cell for operations that can take more than several 
seconds to complete.  There are 2 styles of progress meters: 

 
The discrete progress meter is used for operations where actual progress towards completion can be measured. 
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A marquee progress meter is used where progress to completion is indeterminate. 

 
The left-most cell is also used to show a 1-line help string when tracking icons, menus or pop-up 
menus.  Informational messages are also displayed here such as the coordinates of a point 
dropped or what the last short command just did: 

 
Tracking over any menu item or icon posts a 1-line help message. 

 
Keystroke Commands 

Where possible, all the standard factory-settings for keystroke commands have been retained.  
Some important changes to be aware of include: 

• The ‘Esc’ key replaces the Ctrl-C key combination to interrupt an operation.  Whenever you 
wish to interrupt a long-running operation or dismiss a dialog or prompt, hit the ‘Esc’ key.  The 
Ctrl-C combination is the keystroke for Edit/Copy. 

• Because of the change to handling the Esc command, the old key combinations such as Esc-E 
for ‘edit’ are no longer supported. 

• The ‘F1’ key defaults to Help/Contents.  In previous releases, F1 was the keystroke to enter a 
long command from the keyboard.  To enter long commands, use the ‘:’ (colon) key which by 
default performed this function in previous releases. 

 
Throughout the user interface, keystroke commands have been implemented to conform to 
Windows standard.  If there are keystroke commands for a feature/function in a pull-down menu, 
the keystroke is listed in the menu item: 

 

In the File menu, Ctrl+O is the keystroke combination to open 
a file.  Similarly Ctrl-N will start a new drawing.  Both are 
Windows standard keystrokes for these features. 

 

Mouse Button Assignments 

The applications default to the traditional mouse-button assignments although these can be 
changed according to your preferences in the User Preferences tab of the Tools/Options property 
sheet.  By default the button assignments are: 

• Left-mouse button – digitize points & cursor strokes. 

• Middle-mouse button – activate pop-up menus. 
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• Right-mouse button – track the static icon area. 

In addition to these 3 standard mouse buttons, support has been added for the ‘Forward’ and 
‘Back’ mouse buttons.  As with previous versions, the scroll wheel can be programmed also.  The 
default settings and other choices are set in the Tools/Options dialog on the User Preferences 
tab: 

 
 
The left-right tilt-wheel, while not programmable, is recognized by the software and by default will 
operate the horizontal scroll bar (scroll-left, scroll-right). 
 
In ExpertCAD 3D and ExpertCAD, default behavior is defined when the Ctrl or Shift key is held 
down while digitizing in the graphics area.  Ctrl will select (or unselect) the entity near the cursor 
(i.e. toggle the selected state).  Shift will select the entity near the cursor adding it to the 
collections of entities currently selected (i.e. add to selection). 
 
Scroll Bars 

Horizontal and vertical scroll bars for scrolling a drawing left/right, up/down are enabled by default 
in ExpertCAD.  The scroll bars function according to Windows standard.  If you wish reclaim 
some graphics area, the scroll bars can be disabled and hidden in the Tools/Options dialog. 
 
Drag & Drop Support 

Windows-standard drag & drop of files into the application window is supported.  In ExpertCAD 
and ExpertCAD 3D, if a file is currently being edited, the file is inserted into the drawing otherwise 
the file is opened and becomes the current file being edited.  In ExpertCAM, drag & drop 
functions the same as File/Open.  In all cases only 1 file can be specified and it must be of a file 
format that the application can read. 
 
Popup Menus 

Popup menus are Windows-style pull-right menus as opposed to the stacking-style in previous 
releases.  The title of the pull-right appears in the main menu with its contents in the pull-right. 

Pop-up menus are used for those 
features/functions that are dependent on the 
position of the cursor at the time the function is 
used. 
 
If preconditions for using an item in the menu 
are not met, the item is disabled.  In this 
example, there is no current text so the menu 
item Delete Current Text is disabled. 
 
All items in popup menus (graphics and textual 
menus) have 1-line help messages that are 
displayed in the status bar when that item is 
tracked. 

Many of the features implemented in popup menus in previous releases have migrated to the 
pull-down menus.  Operations that require pre-positioning of the cursor are implemented as 
popup menus. 
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The ‘menustick’ (default menu item) feature is implemented in a Windows standard manner.  The 
default item is in bold text and can be invoked by choosing the text in the main menu. 
 
If you use the library feature, the modules you specify to use will be added to the main popup 
menu: 

In this example, the parametrics, mold 
components and user library are requested. 
 
To bring up the user interface for the library, 
choose its icon in the graphics popup menu. 
 
Note that there are 1-line help messages shown in 
the status bar when you track over an icon in any 
graphic popup menu. 

 
 
ExpertCAD 3D Popup Menus 

 

The Find Delete menu is a renamed version of 
the former FIN/DEL menu.   
 
The same features and functions are provided 
with menu items that provide for greater clarity. 
 

 
The Point Edit menu is a renamed version of 
the former PT EDIT menu. 
 
The menu retains the same order and 
functionality as previous releases.  The menu 
items themselves have been modified for 
clarity as to their purpose. 
 
Menu items are disabled when pre-conditions 
don’t allow their use.  In the example to the left, 
we don’t have a current point so therefore the 
Drag functions for point selection are disabled. 

 

 

The Measure popup menu is functionally the 
same as in previous releases.   
 
Remember that a 1-line help message is now 
available in the status bar when you track over 
an icon. 
 

5 



 
The Snap Point To menu lets you choose whether to snap 
to objects in 3D space or constrain the snap to the current 
workplane.   
 
A check mark is shown next to the snap mode currently in 
effect. 

 
 
ExpertCAD Popup Menus 
 

The Find Delete menu is a renamed version of 
the former FIN/DEL menu.   
 
The same features and functions are provided 
with menu items that provide for greater clarity. 
 
Notice that menu items are disabled when 
conditions for the proper usage do not exist. 

  
The Point Edit menu is a renamed version of 
the former PT EDIT menu. 
 
The menu retains the same order and 
functionality as previous releases.  The menu 
items themselves have been modified for 
clarity as to their purpose. 
 
Note the menu item Filter by Class has a 
checkmark next to it.  This indicates that the 
Filter by Class is currently enabled.  Choosing 
this menu item will toggle its state on and off. 
 
Here again, menu items are disabled when 
pre-conditions don’t allow their use.  In the 
example to the left, we don’t have a current line 
enclosing any entities so therefore the Select 
Enclosed functions for point selection are 
disabled.  
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The Measure popup menu is functionally the 
same as in previous releases.  For clarity the 
icons have been revised in appearance and 1-
line help is provided in the status bar when an 
icon is highlighted. 
 

Drawing Xtras is a replacement for the former 
DRAW popup menu.  Included in this menu are 
the features that modify the current line most of 
which are dependent on the cursor position. 

 
Dialogs 

Windows-style dialogs are used throughout the applications.  The former proprietary dialog look 
and feel has been discarded.  In addition to Windows-standard dialogs, specialized dialogs have 
been added for consistency where required: 

 

The Layer Manager dialog has been converted to a Windows dialog and reworked 
to make it easy to delete, rename or create new named layers because they work 
per Windows standard.   

The Line Style dialog shows 
the true dash pattern and 
width of each line style 
available 
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The Font dialog lists all fonts currently available and provides a preview of your 
selection. 

The color dialog shows all 
available color choices with 
one-click selection. 

 
Menus 
 
The menu set has been modified to conform closely to Windows standards and common practice 
for organization and function.  The menus themselves follow Windows standards for usage: 
 

 

The menus can be navigated using your mouse or the keyboard by 
using the Alt keystroke in combination with other keystrokes.  
Underlined characters indicate the key to use to navigate to that item. 
 
If there is a keystroke (short command) associated with a menu item, 
it will be listed on the menu to right of the text for that item (e.g. the 
Del key will perform the same function as Edit/Delete). 
 
In all cases, menu items are disabled if the proper conditions do not 
exist to use that item.  In this example, Redo is disabled because we 
have not done an Undo yet.  Similarly Paste is disabled because 
there is nothing suitable on the clipboard to paste into ExpertCAD. 
 
When you track over a menu item, a 1-line help message will be 
shown in the status bar to describe its function. 
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ExpertCAD 3D Menus 

 

New – start a new design.  This is the same function as the 
former File/Clear menu item. 
Open – edit a design.  This is the same function as the former 
File/Edit menu item. 
Insert – inserts design data into the current design.  This is t
same function as the former File/Merge menu item. 

he 

Save – save the current design. 
Save As - save the current design to a different file name.  
Note that the file specified becomes the current edit file. 
Save Current Class – save only those drawing items in the 
current class to a file.  Same function as the former Save 
Class menu item. 
Export – output design data in an alternate format.  Options 
for exporting files can be set on the Import/Export tab of the 
Tools/Options property sheet.  

AutoCAD DXF and DWG output is a 
new feature for 2009.  Both options 
respond to the 2D Drawing Export 
settings in the Import/Export tab of 
the Tools/Options dialog. 
 
Windows Bitmap produces a 24-bit 
image of the design in the current 
view as a .bmp file. 

Send To – forward the design data as e-mail or to SofTech’s 
Prospector application for NC machining: 

 

 

Note that the Mail option may not be compatible with e-mail 
programs other than Microsoft Outlook. 
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Create Mold Drawing – this is the same feature as prior 
versions however the submenu contains the choices for output 
instead of posting a dialog. 
 
Page Setup – establishes the printer, paper size, orientation 
and margins you wish to use as a default for printing. 
 
Print – print all or part of the design.  Printing options including 
precise scaling can be specified on the Print/Plot tab in the 
Tools/Options property sheet. 
 
Plot – plot all or part of the drawing using the WinPlot HPGL/2 
plotting application. 
 
Properties – displays the design properties dialog.  This 
replaces the Drawing Mgmt dialog in previous versions. 
 
Recent Files – lists the last 8 most recent files that were 
opened so you can quickly edit one of them by choosing it 
from this menu. 

 

 
 
Undo – reverses the effect of the last change to the design.  Up to 10 
levels of undo/redo are supported. 
Redo – roll-forward the last operation that was undone. 
Cut – puts only the selected design entities on the system clipboard 
and removes them from the design. 
Copy – puts only the selected design entities on the system 
clipboard. 
Paste – inserts the contents of the clipboard at the current point and 
makes those entities selected. 
Select All – selects all design entities. 
Delete – deletes all selected design entities. 

Notes on Cut/Copy/Paste…. 
 
When you use Cut or Copy, the selected entities are written to the system clipboard.  By default 
the data is written in a native 3D format, ExpertCAD format and as a Windows bitmap. This 
allows you to paste the items you selected into another session of ExpertCAD 3D as design 
entities.  This also means that you can Cut & Paste between ExpertCAD 3D and ExpertCAD.   
Because a bitmap is placed on the clipboard, you can paste that into another application that 
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supports bitmaps.  For example, you can use Edit/Paste in Microsoft Word to insert an image of 
what you copied in ExpertCAD 3D into a document.   
 
When you use Edit/Paste in ExpertCAD 3D, it will choose to use the first available format in this 
order: 

1. ExpertCAD 3D native format. 
2. PDB format. 
3. ExpertCAD format. 
4. Text (places a text note into the design at the current point). 

 
When using Cut & Copy, the ExpertCAD and bitmap data is representative of the current view 
when the data is cut or copied.   
 
In the File I/O tab of the Tools/Options dialog you can choose the formats you wish to place on 
the clipboard when Cut or Copy is used in ExpertCAD 3D.   
 
 
 

 

 

Redraw – clears the graphics area and redraws. 

Zoom to Fit – fits the design to the current view. 

Zoom to Fit All – fits the design in all views. 

Zoom to Area – zooms into an area you indicate using the mouse.  

Zoom In/Out – dynamic zoom in/out using the mouse. 

Zoom to Scale – set the view scale to a value you specify. 

Zoom by Factor – scale the view scale by a factor you specify. 

Pan – dynamically pan using the mouse. 

Previous View – return the previous view orientation. 

 
 
 
The Mold and Electrode design menus are unchanged in function.  Cosmetic changes and the 
enabling/disabling of menu items have been added. 
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Tools is a new menu that consolidates various features that 
were formerly scattered throughout other menus in previous 
versions.  
 
Screen Capture – using the mouse, indicate an area of the 
screen to capture as a bitmap and place on the system 
clipboard. 
Engineering Change - posts the engineering change dialog to 
perform a difference between 2 sets of design data. 
Layer Manager – posts the layer manager dialog to delete 
layer names, create new layer names or change layer names. 
Color Editor – posts the color editing dialog to change line 
colors and/or icon colors. 
Options – posts the Options property sheet to set 
preferences. 

 

Tools/Options Property Sheet 

The Options property sheet replaces the functions formerly found in dialogs posted from the SET-
UP popup menu.   

 
 
Clicking on a tab on the property sheet brings that dialog to the forefront for entering your 
preferences. 
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Click OK to accept changes to all the dialogs.  Click Apply to accept changes to the current 
dialog.  The settings will be saved to your personal configuration file: 

C:\<Personal application data>\ SofTech\ToolDesigner\ExpertCAD3D-Setup.cfg 
Where <Personal application data> is typically: 

Windows 2000/XP - C:\Documents and Settings\<user>\Application Data 
Windows Vista - C:\Users\<user>\AppData\Roaming 

 
Never edit the file ExpertCAD3D-Setup.cfg.  This file is created and re-written by the Options 
dialog.  Any changes or edits you might make will be lost the next time you use the Options dialog 
to change a setting. 
 
The Draw menu replaces the former POINT and BUILD popup menu.  The same features and 
functions have been consolidated into this single menu: 
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ExpertCAD Menus 

 
  

 

New – start a new drawing.  This is the same function as the 
former File/Clear menu item. 
Open – edit a drawing.  This is the same function as the former 
File/Edit menu item. 
Save – save the current drawing. 
Save As - save the current drawing to a different file name.  
Note that the file specified becomes the current edit file. 
Save Current Class – save only those drawing items in the 
current class to a file.  Same function as the former Save Class 
menu item. 
Export – write the drawing to a file in your choice of formats: 

 

Options for exporting files can be set on 
the Import/Export tab of the 
Tools/Options property sheet.  
HSF is a new option to output the 
drawing in Hoops Streaming Format.  
This format can be read by popular 
viewing programs such as SolidWorks 
eDrawings. 
Windows Bitmap writes the drawing as 
a .bmp file full size according to the 
current screen resolution and at the 
color depth (32, 24, … bits per pixel). 

Send To – forward the drawing data as e-mail or to SofTech’s 
Prospector application for NC machining: 

 

Note that the Mail option 
may not be compatible 
with e-mail programs other 
than Microsoft Outlook. 

Page Setup – establishes the printer, paper size, orientation and 
margins you wish to use as a default for printing. 
Print – print all or part of the drawing.  Printing options including 
precise scaling can be specified on the Print/Plot tab in the 
Tools/Options property sheet. 
Plot – plot all or part of the drawing using the WinPlot HPGL/2 
plotting application. 
Properties – displays the drawing properties dialog.  This 
replaces the Drawing Mgmt dialog in previous versions. 
Recent Files – lists the last 8 most recent files that were opened 
so you can quickly edit one of them by choosing it from this 
menu. 
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Undo – reverses the effect of the last change to the drawing.  Up to 
10 levels of undo/redo are supported. 
Redo – roll-forward the last operation that was undone. 
Cut – puts only the selected drawing entities on the system 
clipboard and removes them from the drawing. 
Copy – puts only the selected drawing entities on the system 
clipboard. 
Paste – inserts the contents of the clipboard at the current point 
and makes those entities selected. 
Select All – selects all drawing entities. 
Delete – deletes all selected drawing entities. 
 

 
Notes on Cut/Copy/Paste…. 
 
When you use Cut or Copy, the selected entities are written to the system clipboard in 
ExpertCAD format and as a Windows bitmap.  This allows you to paste the items you selected 
into another session of ExpertCAD as drawing entities or into another application that supports 
bitmaps.  For example, you can use Edit/Paste in Microsoft Word to insert an image of what you 
copied in ExpertCAD into a document.  The bitmap picture created by Cut/Copy is dependent on 
the zoom scale at the time you cut or copy the image.  If you need a smaller bitmap image, zoom 
out where zooming in will create a larger image.  It is not necessary for the selected entities to be 
visible in the graphics area for a complete image to be created. 
 
When you use Edit/Paste in ExpertCAD, it will choose to use native ExpertCAD data if it is 
available on the system clipboard.  If that format does not exist, it will choose to use a text format 
if that is available and insert the data as a text note.  This allows you to copy textual data from 
Microsoft Word or Excel into ExpertCAD. 
 
 

 

The View pull-down menu replaces the former popup View menu in 
previous releases. 
 
Redraw – clears the graphics area and redraws. 
Zoom to Fit – fits the drawing to the graphics area. 
Zoom to Area – zooms into an area you indicate using the mouse.   
Zoom In/Out – dynamic zoom in/out using the mouse. 
Zoom to Scale – set the view scale to a value you specify. 
Zoom by Factor – scale the view scale by a factor you specify. 
Pan – dynamically pan using the mouse. 
Previous View – return the previous view orientation. 
Display Grid – show or disable a visible grid. 
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Insert is a new menu that implements certain functions 
formerly found on the File menu. 
 
Drawing – inserts (merges) a drawing into the current 
drawing you are working on.  This is the same function as the 
former File/Merge… menu item. 
New Symbol – creates a symbol from an ExpertCAD file. 
Call to a Symbol – places a call to a symbol at the current 
point.  This is the same function as the former File/Call… 
menu item. 
Update Symbol Definition – updates the definition of a 
symbol from the contents of its original disk file.  This is the 
same function as the former File/Recall… menu item. 

 

 

Tools is a new menu that consolidates various features that 
were formerly scattered throughout other menus in previous 
versions.  
 
Screen Capture – using the mouse, indicate an area of the 
screen to capture as a bitmap and place on the system 
clipboard. 
Engineering Change - posts the engineering change dialog to 
perform a difference between 2 drawings. 
Purge – rids the drawing data of unused and/or unwanted text 
buffers or dimension character definitions. 
Layer Manager – posts the layer manager dialog to delete 
layer names, create new layer names or change layer names. 
Color Editor – posts the color editing dialog to change line 
colors and/or icon colors. 
Options – posts the Options property sheet to set 
preferences. 

 
 
The Draw menu replaces the former POINT and BUILD popup menu.  The same features and 
functions have been consolidated into this single menu: 
 

 

 
 
 
 

 

The Draw Menu The Points Submenu The Splines Submenu 
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Tools/Options Property Sheet 

The Options property sheet replaces the functions formerly found in dialogs posted from the SET-
UP popup menu.   

 
 
Clicking on a tab on the property sheet brings that dialog to the forefront for entering your 
preferences. 
 
Click OK to accept changes to all the dialogs.  Click Apply to accept changes to the current 
dialog.  The settings will be saved to your personal configuration file: 

C:\<Personal application data>\ SofTech\ExpertCAD\ExpertCAD-Setup.cfg 
Where <Personal application data> is typically: 

Windows 2000/XP - C:\Documents and Settings\<user>\Application Data 
Windows Vista - C:\Users\<user>\AppData\Roaming 

 
Never edit the file ExpertCAD-Setup.cfg.  This file is created and re-written by the Options dialog.  
Any changes or edits you might make will be lost the next time you use the Options dialog to 
change a setting. 
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Printing from Windows in ExpertCAD, ExpertCAD 3D and ExpertView 
The print feature has been completely redone to allow more flexibility and choices for output.   
 
Page Setup has been added to the File menu to allow you to choose a default printer and set the 
characteristics for that printer.  The choices you make in the Page Setup dialog will be used as 
the default when you print although you will have the option to choose a different printer and 
settings when the print dialog is posted.  These settings are persistent and will be restored when 
you start future sessions of the application.  If you don’t use the Page Setup feature, the default 
settings will be those of the default printer set for your computer. 
 
In the Print/Plot dialog in the Tools/Options property sheet, you can choose to set the scale at 
which you want the drawing to be printed: 
 

The Fit drawing to paper switch is enabled by default.  
This means the software will scale the output to fit the 
drawing to the paper size you have chosen taking into 
account the current margins. 

 

If you want to print at a specific scale, un-check the 
switch Fit drawing to paper then enter the scale at which 
to print the drawing.  In this example, we’re using 1.0 
which means a full scale drawing. 

 
Regardless of whether you choose the Fit option or a specific scale, the scaling method aligns the 
center of your drawing with the center of the printable area of the page as specified by the paper 
size and margins.  The scale is applied relative to this center point. 
 
Line width replaces the function of the former “Line Width Factor” in previous releases.  Line 
width specifies how wide a 1 pixel wide (e.g. style 0) line on the screen should be drawn when 
printed.  The value specified is always in inch regardless of the system of units. 
 
In ExpertCAD 3D you can choose the view of the design you wish to print on this same dialog: 

 
The standard views as well as the orientation of the current view are the options available to you 
in the menu.   
 
The ability to print multiple copies is supported provided your printer supports this feature. 
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Platform Support 
Supported platforms for ToolDesigner 2009 are: 

 
Computer Operating System Revision Level 
Intel & AMD 32-bit Computers Windows 2000 Service Pack 3 or higher 
Intel & AMD 32-bit Computers Windows XP All 
Intel & AMD 64-bit Computers Windows XP x64 Edition All 
Intel & AMD 32-bit Computers Windows Vista 32-bit Edition All 
Intel & AMD 64-bit Computers Windows Vista 64-bit Edition All 
  
Important Notes about Platform Support 

1.   Windows XP x64, Windows Vista 32-bit & 64-bit require the use of the USB style 
security key.  Parallel port security keys are not supported on these operating systems. 

 2.  If you are installing on Windows 2000, you must make sure you have Windows 2000 
Service Pack 3 or later installed before you attempt to install ToolDesigner.  The software 
will not install correctly nor will it run if you are not at this level of the operating system. 

Installation 
ToolDesigner 2009 is intended to be installed in a different path than previous versions of the 
software. 
 

Do not install the software in the same path as previous releases! 
 
ToolDesigner 2009 is intended to run side-by-side with previous releases.  You do not need to 
remove a previous release from your system prior to or after installing ToolDesigner 2009.  Treat 
this release as if you were installing an entirely new product.  Both ToolDesigner 2009 and 
previous releases are treated as completely separate applications as far as Windows is 
concerned.  They don’t have anything in common in terms of using system resources. 
 
For these reasons, we strongly recommend you accept the default installation path: 
 

C:\Program Files\ToolDesigner 2009 
 
After installation, a new program group – ToolDesigner 2009 – is created and added to the start 
menu: 

 
Both ToolDesigner 7.7 and ToolDesigner 2009 are installed on this computer. 

 
One of the final steps during installation is the installation of the driver for Aladdin USB dongles.  
If the driver has not been previously installed or a newer version needs to be installed, this will be 
done by the installation program.  In previous versions the driver installation was performed 
without user interaction however with this release, the dialog shown below will be presented: 
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Click OK when this dialog is presented and the installation process will proceed. 
 
New Paths for Configuration Files 

Previous versions of ToolDesigner installed all software components underneath the root 
installation directory (e.g. c:\Program Files\ToolDesigner).   This scheme was problematic 
because users without administrative rights could not create or modify certain files as needed to 
configure the software.  This is especially true with the Windows Vista operating system.  With 
this release and future releases, all files and directories that a user may need to modify or 
manage are installed in these directories: 
 
Common application data – this directory contains files and folders that are used or referenced by 
the software for all users of the computer.  The defaults are: 

O/S Path 
Windows Vista C:\Program Data\SofTech\ToolDesigner 
Windows XP/2000 C:\Documents and Settings\All Users\Application Data\SofTech\ ToolDesigner 
 
Personal application data – this directory contains files and folders that are used by the software 
for a particular user of the computer.  Therefore this directory will be different for each user.  The 
defaults are: 

O/S Path 
Windows Vista C:\Users\<user>\AppData\Roaming 
Windows XP/2000 C:\Documents and Settings\<user>\Application Data 
 
Where <user> is the user login.  Underneath these folders, the folder SofTech and subfolder 
ExpertCAD is created.  For example, on Windows Vista: 

C:\Users\<user>\AppData\Roaming\SofTech\ToolDesigner 
 
If you are unsure about the location of these folders, choose the File Locations tab on the Options 
property sheet in ExpertCAD 3D or ExpertCAD: 
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Data files and directories affected by this change include: 
 
ExpertCAD 3D Custom Configuration File for Current User 

Old Path:  C:\<User’s Profile Folder>\expcad3d.cfg 
New Path:  C:\<Personal application data>\ExpertCAD3D.cfg 

 
ExpertCAD 3D Custom Configuration File for All Users 

Old Path:  C:\Program Files\ToolDesigner\expcad3d\global.cfg 
New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAD3D.cfg 

 
ExpertCAD 3D Custom Short Key Definitions 

Old Path:  C:\<User’s Profile Folder>\expcad3dshorts.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD3D-ShortKeys.cfg 
 

ExpertCAD 3D Custom Cursor Stroke Definitions 
Old Path:  C:\<User’s Profile Folder>\expcad3dstrks.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD3D-Strokes.cfg 

 
ExpertCAD 3D Custom Quick Menu (Graphic Popup Menu) 

Old Path:  C:\<User’s Profile Folder>\expcad3dpopup.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD3D-QuickMenu.cfg 

 
ExpertCAD 3D Electrode Example Files 
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 Old Path:  C:\Program Files\ToolDesigner\electrode\examples 
 New Path:  C:\ProgramData\SofTech\ ToolDesigner\Electrode Examples 
 
ExpertCAD 3D Electrode Holder Files 
 Old Path:  C:\Program Files\ToolDesigner\electrode\holders 
 New Path:  C:\ProgramData\SofTech\ ToolDesigner\Electrode Holders 
 
ExpertCAD 3D User Interface Macro Files 

Old Path:  None.  Files were not distributed. 
New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAD 3D Macros 
 

ExpertCAD 3D Macro Libraries (Init_user, Icons_user) 
 Old Path:  C:\Program Files\ToolDesigner\expcad3d\libs 
 New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAD 3D Libraries 

 
ExpertCAD 3D OSM Example Files 
 Old Path:  C:\Program Files\ToolDesigner\osmtool 
 New Path:  C:\ProgramData\SofTech\ToolDesigner\OSM Examples 
 
 
ExpertCAD & ExpertCAD 3D Stroked Font Files (cadFont1, cadFont2, …) 
 Old Path:  C:\Program Files\ToolDesigner\fonts 
 New Path:  C:\ProgramData\SofTech\ ToolDesigner\Fonts 
 
ExpertCAD Macro Libraries (Init_us, Icons_us, Init_pm, Icons_pm) 
 Old Path:  C:\Program Files\ToolDesigner\expcad\libs 
 New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAD Libraries 
 
ExpertCAM Macro Libraries (Init_us, Icons_us) 
 Old Path:  C:\Program Files\ToolDesigner\expcam\libs 
 New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAM Libraries 
 
AutoCAD Translator Configuration Files 
 Old Path:  C:\Program Files\ToolDesigner\AutoCAD 
 New Path:  C:\Progran Data\SofTech\ToolDesigner\AutoCAD 
 
WinPlot Plotcap.txt File 

Old Path:  C:\Program Files\ToolDesigner\winplot\plotcap.txt 
New Path:  C:\ProgramData\SofTech\ToolDesigner\WinPlot\plotcap.txt 

 
Custom Mold Components 

Old Path:  C:\Program Files\ToolDesigner\expcad\data\mold 
New Path:  C:\ProgramData\SofTech\ToolDesigner\Mold Components 

 
ExpertCAD User Interface Macro Files 

Old Path:  C:\Program Files\ToolDesigner\expcad\macros 
New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAD Macros 

 
ExpertCAM User Interface Macro Files 

Old Path:  C:\Program Files\ToolDesigner\expcam\macros 
New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAM Macros 

 
ExpertCAD Example Files 

Old Path:  C:\Program Files\ToolDesigner\expcad\examples 
New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAD Examples 
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ExpertCAD Custom Configuration File for All Users 
Old Path:  C:\Program Files\ToolDesigner\expcad\global.cfg 
New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAD.cfg 

 
ExpertCAM Custom Configuration File for All Users 

Old Path:  C:\Program Files\ToolDesigner\expcam\global.cfg 
New Path:  C:\ProgramData\SofTech\ToolDesigner\ExpertCAM.cfg 

 
ExpertCAD Custom Configuration File for Current User 

Old Path:  C:\<User’s Profile Folder>\expcad.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD.cfg 

 
ExpertCAM Custom Configuration File for Current User 

Old Path:  C:\<User’s Profile Folder>\expcam.cfg 
New Path:  C:\<Personal application data>\ ExpertCAM.cfg 

 
ExpertCAD Settings Established in the Options Dialog (SET-UP menu in previous versions) 

Old Path:  C:\<User’s Profile Folder>\cadsetup.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD-Setup.cfg 

 
ExpertCAM Settings Established in the Options Dialog (SET-UP menu in previous versions) 

Old Path:  C:\<User’s Profile Folder>\expcam.cfg 
New Path:  C:\<Personal application data>\ ExpertCAM-Setup.cfg 

 
ExpertCAD Custom Short Key Definitions 

Old Path:  C:\<User’s Profile Folder>\cadshort.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD-ShortKeys.cfg 

 
ExpertCAM Custom Short Key Definitions 

Old Path:  C:\<User’s Profile Folder>\expcamshorts.cfg 
New Path:  C:\<Personal application data>\ ExpertCAM-ShortKeys.cfg 

 
ExpertCAD Custom Cursor Stroke Definitions 

Old Path:  C:\<User’s Profile Folder>\cadstrks.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD-Strokes.cfg 

 
ExpertCAM Custom Cursor Stroke Definitions 

Old Path:  C:\<User’s Profile Folder>\expcamstrokes.cfg 
New Path:  C:\<Personal application data>\ ExpertCAM-Strokes.cfg 

 
ExpertCAD Custom Colors Defined Using the Color Editor Dialog 

Old Path:  C:\<User’s Profile Folder>\cadcolor.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD-Colors.cfg 

 
ExpertCAM Custom Colors Defined Using the Color Editor Dialog 

Old Path:  C:\<User’s Profile Folder>\expcamcolors.cfg 
New Path:  C:\<Personal application data>\ ExpertCAM-Colors.cfg 

 
ExpertCAD Standard Text Note Definitions 

Old Path:  C:\<User’s Profile Folder>\cadnotes.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD-StandardNotes.cfg 

 
ExpertCAD Custom Quick Menu (Graphic Popup Menu) 

Old Path:  C:\<User’s Profile Folder>\cadpopup.cfg 
New Path:  C:\<Personal application data>\ ExpertCAD-QuickMenu.cfg 
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ExpertCAM Custom Quick Menu (Graphic Popup Menu) 
Old Path:  C:\<User’s Profile Folder>\expcampopup.cfg 
New Path:  C:\<Personal application data>\ ExpertCAM-QuickMenu.cfg 

 
ExpertCAM Post Processor Configuration File 
     Old Path:  C:\Program Files\ExpertCAD\expcam\posts\expcamposts.cfg 
     New Path:  C:\ProgramData\SofTech\ExpertCAD\ExpertCAM-Posts\ExpertCAM-Posts.cfg 
 
ExpertCAM Post Processor Files & Folders 

Old Path:  C:\Program Files\ExpertCAD\expcam\posts\ 
New Path:  C:\ProgramData\SofTech\ExpertCAD\ExpertCAM-Posts\ 

 
During installation, the files and folders that pertain to all users are migrated (copied and 
renamed) to their proper location.  You do not have to manually copy and rename any of these 
files. 
 
The first time you run ExpertCAD 3D, ExpertCAD or ExpertCAM, the programs will look for 
personal configuration files from a previous release.  If any of these files exist, they will be 
migrated (copy and renamed) to reflect their proper location in the new installation scheme. 
  
When installing on a system that did not have a previous version of the software installed, default 
configuration files will be installed.  If you have customized configuration files from a previous 
release, you will need to copy these to their new location manually. 
 

Adobe PDF Output 

In addition to fitting the drawing to the paper 
size, you now have the option in both 
ExpertCAD and ExpertCAD 3D  to output the 
drawing to a precise scale.  Disable the 
switch Fit to paper size and enter the scale 
you wish.  Output will be sized accordingly 
and centered on the sheet. 

Margins for the paper size can be specified in 
the conversion settings dialog. 

Dash patterns and line widths are rendered 
by Adobe Acrobat whereas in previous 
releases the dashing and line widths were 
approximated by ExpertCAD.  You can fine 
tune the both by adjusting the line width and 
dash length factors. 

Line cap specifies the appearance of a line at 
the end points.  Line join specifies how the 
line is to be rendered at the vertex of 2 
adjoining line segments. 

 

Closed Track IDs 
The following is a list of closed customer and internally generated software enhancements, 
corrections and modifications included in this release with a synopsis of the problem or 
enhancement that has been addressed. 
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ID Synopsis 
62 Call to a symbol causes ExpertCAD screen to erase and redraw unnecessarily. 
88 Double-click in the File dialog can cause a point to be added to the current line. 
194 Add an option or command to allow a dialog to be posted for choosing directories only. 

234 When reading files in ExpertCAD 3D, the messages in the scroll area indicate the operation is 
complete when it is not. 

302 Installation is incorrect & incomplete when installing on a terminal server edition of Windows. 
313 Sort the output for the command "what classes" in ExpertCAD 3D. 
319 Double-click in the File dialog can cause a point to be added to the current line. 
394 Installation can cause conflicts with prior editions of ExpertCAD. 
419 Add help messages when tracking over graphic pop-up menus to describe their function. 
596 Add additional user preferences to ExpertView (scroll lines, printing & plotting options). 
604 Changing extension line offset for dimensions in ExpertCAD 3D has no effect. 
605 Choosing pointer focus for window activation can cause the application to hang. 
639 ExpertCAD will overwrite files that are designated as read-only. 
650 Change the way the Save As feature works to conform to Windows standard. 
661 Add support for the terminal server editions of MS Windows. 
767 Add help messages in the status bar when tracking over menus (pull-down and pop-ups). 
791 Add ExpertCAD as an option when choosing Custom for installation. 
804 Add a most recently used file listing to the File menu. 
819 The menu-stick feature is not working properly for the measure-angle graphic popup. 
827 Add ExpertCAD as an option when choosing Custom for installation. 
837 Add e-mail Send to Mail Recipient as a feature in the File menu. 
917 Add the ability to drag & drop a file into an ExpertCAD or ExpertCAD 3D window. 
991 Add a setting for the number of decimal places for measurement in ExpertCAD 3D. 
993 When writing files in PDB format from ExpertCAD 3D, the order of the prompts/dialogs is incorrect. 
1011 User interface for sizing balloon notes is not intuitive in ExpertCAD. 

1019 Add a tabbed Options dialog to replace the SET-UP popup menu for ExpertCAD and ExpertCAD 
3D. 

1092 Memory allocation for IGES translation is inefficient. 
1098 Installation should not overwrite library macros for mold components. 
1179 Change the way the Save As feature works to conform to Windows standard. 

1221 The point edit menu in ExpertCAD 3D should prompt for incremental distances when a current line 
is not used. 

1225 The error messages for the planar surface feature in ExpertCAD 3D are confusing and not helpful. 

1226 The 'm' short command in ExpertCAD 3D produces poor error messages when it fails to find a 
geometric center point. 

1230 The 'f' short command in ExpertCAD 3D generates inappropriate error messages. 
1252 Add a most recently used file listing to the File menu. 
1312 The workplane symbol should never appear on a plot produced from ExpertCAD 3D. 

1314 Revise the internal implementation of plotting from ExpertCAD 3D to use 2D ExpertCAD methods 
to produce the output. 

1337 Add ability to change the number of lines in the scroll area for ExpertView 
1338 Add user interface to the shrink factor for printing to ExpertView. 
1365 Can not produce a monochrome plot file format from ExpertCAD 3D. 
1428 Add ability to be able to re-program the pull-down menus from a macro. 
1433 Change the File menu to conform to Windows standards for application software. 
1449 Application does not start unless the user has write privileges for eXceed directory.  
1465 Contents of some dialog items are cleared when a resize event occurs. 

1489 When writing an ExpertCAD file from ExpertCAD 3D, the software reports it's finished when it 
hasn't finished writing the file. 

1546 Add ability to be able to re-program the pull-down menus from a macro. 
1565 Cursor sometimes jumps across the screen when choosing an item from the Measure popup. 
1566 Popup menus post off the screen if the cursor is too close the edge of the window. 
1638 Ensure the proper extension (.dxf or .dwg) is added to the file name when writing to AutoCAD. 
1643 Revise the engineering change dialog in ExpertCAD 3D to be like ExpertCAD (i.e. easier to 
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understand). 

1659 The 'I' short command (post the File I/O popup menu)  in ExpertCAD 3D should be removed from 
the Windows version. 

1693 Revise the engineering change dialog in ExpertCAD 3D to be like ExpertCAD (i.e. easier to 
understand). 

1732 The library icon for 3rd party software disappears in ExpertCAD 3D when a new design is started. 
1752 Increase the number of icons that can be inserted into a graphic popup menu. 
1810 Add an option to set a precise scale when writing the design as a PDF file. 

1816 Remove many of the unnecessary and annoying prompts when writing PDB or ExpertCAD files 
from ExpertCAD 3D. 

1831 Remove unwanted entry in system registry for printing. 
1860 ExpertCAD 3D will not merge in this file after an edit of the supplied 3D file. 
1871 Remove icon pad for choosing a library module. 
1872 The per-bisector construction line feature in ExpertCAD fails if point is at the center of a circle. 
1892 ExpertCAD will sometimes not allow a read-only file to be opened. 
1902 The right Alt key does not function properly.  Should give focus to the menus. 
1913 Popup menus post off the screen if the cursor is too close the edge of the window. 
1914 Cursor position is incorrect if the measure graphic popup is posted to close window edge. 
1915 Increase the number of icons that can be inserted into a graphic popup menu. 
1973 Add help messages when tracking over graphic pop-up menus to describe their function. 
1991 Printing from ExpertCAD 3D will sometimes omit dimensions. 
2082 Screen does not remain inverted if File/Clear is chosen. 
2111 Add zoom function to the mouse wheel for the render plug-in for ExpertCAD 3D. 
2123 The appearance of the pull-down menus is poor when running with an inverted screen. 
2201 The set-lib command sometimes fails to function properly. 
2211 The count column in the layer dialog for ExpertCAD is off by 1 for line entities.   
2111 Add zoom function to the mouse wheel for the render plug-in for ExpertCAD 3D. 
2225 Missing menu item Whats New in the Help menu for ExpertView. 
2238 If text is selected in ExpertCAD 3D the text is drawn in black when printed instead of its true color. 
2247 Add ability to get the full path names for system variables line INSTALL_PATH. 
2266 File dialog should be posted the first time a call to a symbol is requested in ExpertCAD. 
2267 The Circle Tangent to 2 Entities construction line doesnt work if 2 circles are input in ExpertCAD. 
2271 Default action for the short key Del should delete all selected entities. 

2282 When importing and ExpertCAD file that is not ANSI standard into ExpertCAD 3D, dimensions 
should be flattened to lines and text to retain their proper appearance. 

2283 Dimension symbols (+/-, degree, ...) are ignored when an ExpertCAD file is imported into 
ExpertCAD 3D. 

2318 Add e-mail Send to Mail Recipient as a feature in the File menu. 
2331 The default font for dialogs is poor.  Would prefer a larger font size. 
2371 ExpertCAD 3D can periodically hang when the waterline dialog(s) are posted. 
2384 Add Windows-style dialog and behavior for the Find Text feature for ExpertCAD. 
2389 Remove dependency on an X-Windows server for display. 
2393 Add ability to save a drawing is HSF format from ExpertCAD. 
2489 Add ability to reprogram what the mouse wheel does. 
2499 Titles in some dialogs are not correct.  Title should reflect the function of the dialog. 
2505 Add support for the tilt-wheel mouse feature. 
2506 Add support for the Forward & Back mouse buttons. 
2512 Revise installation scheme to put configuration files in the appropriate directories. 
2528 Add zoom function to the mouse wheel for the render plug-in for ExpertCAD 3D. 
2530 Capture feature is broken. 
2531 Revise installation to place help files in a directory separate from program files. 

2534 Graphic applications (e.g. notepad, WinPlot) started from an application sometimes do open on 
top of the application. 

2543 Entering text into a edit box in a dialog gets erased if a redraw occurs in ExpertCAD. 
2544 This section in ExpertCAM gets distorted when its direction is reversed. 

2546 Render plug-in for ExpertCAD 3D sometimes does not refresh when the window is brought to the 
top. 
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2549 Add Cut/Copy/Paste feature to ExpertCAD 3D. 
2550 Incorrect processing messages for IGES translator. 
2551 The .txt filter should be used in the file dialog for the File to Current Text feature in ExpertCAD. 
2552 Title block in this AutoCAD DWG drawing is missing after translation to ExpertCAD 
2555 Surface Top Of Blank feature is producing incorrect fillets in this example. 
2559 Surface Top Of Blank feature is producing incorrect fillets in this example. 
2560 When merging this ExpertCAD into ExpertCAD 3D, the text on the design is incorrectly sized. 
2564 This IGES file can not be imported into ExpertCAD 3D. 
2571 Embed Microsoft-standard version information in all binary executable files. 
2573 The rotate class operator in ExpertCAD 3D does not have an option to allow text notes to rotate. 
2575 ExpertCAD 3D is failing to read files that are on the Windows desktop. 
2579 This IGES data file will not convert to ExpertCAD format. 
2580 Add default behaviors for Ctrl-click and Shift-click mouse events. 

2581 The grab-edge feature ('e' short command) does not work on all edges of an electrode blank 
entity. 

2583 Add the ability to write IGES data by class in ExpertCAD. 
2585 Unnecessary and unwanted fonts are being installed when ExpertCAD is installed. 
2587 Corner marker for electrodes is omitted when IGES is exported. 
2591 Angle output has the incorrect number of decimal places in the electrode burn position file.  
2594 When ExpertView is installed by itself, the GNU software does not get installed. 
2595 Diameter dimensions (dimen 6) does not always draw in the dimension color (UNIX only). 
2596 The QB command line option for batching does not work in Version 7.7 of ExpertCAD 
2597 Add support for reading ME-10 format files to ExpertCAM and ExpertCAD. 
2598 This DXF file will not convert to ExpertCAD format. 
2601 This AutoCAD DWG file will not convert to ExpertCAD format. 
2613 Surface/Surface fillet operation never completes in this example. 
2617 This AutoCAD DWG file will not convert to ExpertCAD format. 
2618 This AutoCAD DXF file will not convert to ExpertCAD format. 
2622 When using wide lines, arrowheads for dimensions extend past the leader lines in PDF output. 
2624 ExpertCAM is ignoring the go-to directory setting when working with databases. 
2625 The Outline class operator is not creating the correct results in this discrete case. 
2628 Batch output from WinPlot can be different than when it is run interactively. 
2629 Fillet feature in ExpertCAD 3D is not trimming back input surfaces correctly in this example file. 
2630 Calls to symbols with invisible entities become visible when converted to AutoCAD format. 
2631 The AutoCAD solid fill entity in this file is not converting properly to ExpertCAD format. 
2633 Insert pocket builder is failing to produce the correct results for this input data. 

2634 Cookie-cutter trim feature in ExpertCAD 3D is not sorting surfaces inside and outside the trimming 
profile correctly. 

2636 Cant read this Cadra file into ExpertCAD on an AMD system.  Intel-based computers are OK. 
2637 Can't convert this IGES file to ExpertCAD. 
2638 ExpertCAD cant read this Cadra file. 
2639 Confusing errors emitted from ExpertCAD if the radius of a circle tangent to 2 circles is too small. 
2640 This DXF file will not convert to ExpertCAD format. 
2642 Add a command line option to allow selection of ExpertCAD or ExpertView license. 
2643 This DXF file will not convert to ExpertCAD format. 
2644 2 text notes in this AutoCAD drawing are not being translated properly. 
2646 Block entities in this AutoCAD file that are not scaled correctly when translated to ExpertCAD. 
2647 Add support for reading & writing AutoCAD 2007/2008 files in ExpertCAD. 
2652 A segmentation violation error is reported when this ExpertCAD file is edited. 
2653 Purge text buffers should not report buffers associated with text notes as unnecessary. 
2655 Enhance Cut & Copy to place a bitmap of the data on the clipboard. 
2656 Can't convert this IGES file to ExpertCAD. 
2657 Can't read this Cadra file into ExpertCAD. 

2658 On edit, clear out all non-standard dimension characters defined in ExpertCAD before reading the 
file. 

2659 Disabling the auto position text feature in ExpertCAD for dimensions doesn't work for vertical 
dimensions. 
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2661 Writing a PDF file causes ExpertCAD to think that the drawing has changed somehow. 
2662 Add the ability to print multiple copies of a drawing. 
2663 Add options to set margins, line caps & joins and use Adobe PDF line drawing. 
2667 The text in this AutoCAD drawing is shifted slightly in X when translated to ExpertCAD 
2668 Default the system of units used as the default based on the locale information from Windows. 
2672 Use a default font in cases where a custom font is unavailable or the font file is corrupt. 

2697 When importing and ExpertCAD file that is not ANSI standard into ExpertCAD 3D, dimensions 
should be flattened to lines and text to retain their proper appearance. 

2704 Add Ctrl-TAB short command to tab through the different sets of icons. 

2712 The Create Mold Drawing feature in ExpertCAD 3D doesn't handle ellipses properly when they lie 
in the plane of the view. 

2721 The graphic display for tracking icons with the 3D appearance setting enabled could be better. 

2722 The Engineering Change feature in ExpertCAD 3D doesn't honor the settings for layer 
assignment. 

2724 ExpertCAD 3D ignores out of range values for color assignment. 
2734 AutoCAD drawings with dimensions that have mirrored text do not translate properly. 
2740 This DXF file written from ExpertCAD can’t be read back into ExpertCAD. 
2741 Can’t import this DWG file into ExpertCAD. 

2747 ExpertCAD 3D can not import IGES files over the network with a UNC path.  The drive must be 
mapped first. 

2748 Add an option to change the font and font size for the message area. 
2755 These IGES files will not import into ExpertCAD 3D. 

2782 Importing this AutoCAD file that contains an invalid text note causes the drawing to disappear on 
the screen. 

2783 AutoCAD files with an invalid text spacing (0.0) are failing to import into ExpertCAD. 
2784 Support import of AutoCAD text notes that have the 'auto-wrap' characteristic enabled. 
2790 The ScriptLink command 'lines2list' is corrupting memory possibly causing the application to crash. 

2791 The centerline extension setting in the Options dialog is not being saved to the configuration file in 
ExpertCAD. 

2793 If a block with waterlines is flattened in ExpertCAD 3D, the software will sometimes crash. 

2798 Output both the radius and diameter size when measuring and arc in ExpertCAD and ExpertCAD 
3D. 

2799 The analysis function of the parametrics module for ExpertCAD is failing in this example. 
2800 The help message for an icon is not always shown in the status bar. 
2801 Can not import this IGES format file into ExpertCAD 3D. 

2803 When the drawing standard is set to BS8888 then menu in the dialog shows the standard is BS 
the next time it is posted. 

2805 Add the ability to export AutoCAD files directly from ExpertCAD 3D. 

2809 Add tool-tips to the icons so a help message is posted to the screen when the cursor is over an 
icon. 

2810 Add on-screen display of 2D and 3D coordinate near the cursor in both ExpertCAD and 
ExpertCAD 3D. 

  
 


	ToolDesigner Release Summary
	Overview
	Welcome to the next generation of ToolDesigner for Windows.  The ToolDesigner applications have been transformed into true Windows applications.  As a necessary part of this transformation, the user interface has been dramatically changed to adopt Windows-standard features and appearance while retaining the unique characteristics such as cursor strokes that makes the software so productive.
	This document will serve as your guide to these major changes in the user interface including the new features and functions now possible.  Although major changes have been made, you will find it very easy to adapt to this new version because wherever possible, Windows standards and industry conventions have been followed.
	Windows User Interface Overview
	This section describes the changes to the user interface.  The examples shown are typically for ExpertCAD and/or ExpertCAD 3D however all applications use the same user interface layout and usage.
	General Window Layout
	The same general layout of the window has been retained:
	 Windows menus along the top of the window.
	 Central graphics area for display of the drawing or NC cutter path.
	 Static icons along the right-hand side.
	 Pop-up menus.
	 A message area at the bottom of the screen for prompts and messages.
	Status Bar
	A Windows-style status bar has been added to the bottom of the window:
	This status bar replaces the old ‘headline’ in previous versions.  Clicking in any of the cells that report the current layer, units, etc. will cause a dialog or prompt to allow you to quickly change their status just as with the former headline.
	In the left-most cell of the status bar, the coordinates of the cursor will be shown & updated as you move the cursor around the drawing.  Holding down the ‘Shift’ key while moving the mouse will report precise coordinates of geometry nearby:
	Holding down the Ctrl key will provide an on-screen display the coordinates as a tool tip popup window:
	Display of the coordinates on-screen and in the status bar can be disabled in the User Preferences tab of the Tools/Options dialog.
	A progress meter is shown in the left-most cell for operations that can take more than several seconds to complete.  There are 2 styles of progress meters:
	The discrete progress meter is used for operations where actual progress towards completion can be measured.
	A marquee progress meter is used where progress to completion is indeterminate.
	The left-most cell is also used to show a 1-line help string when tracking icons, menus or pop-up menus.  Informational messages are also displayed here such as the coordinates of a point dropped or what the last short command just did:
	Tracking over any menu item or icon posts a 1-line help message.
	Keystroke Commands
	Where possible, all the standard factory-settings for keystroke commands have been retained.  Some important changes to be aware of include:
	 The ‘Esc’ key replaces the Ctrl-C key combination to interrupt an operation.  Whenever you wish to interrupt a long-running operation or dismiss a dialog or prompt, hit the ‘Esc’ key.  The Ctrl-C combination is the keystroke for Edit/Copy.
	 Because of the change to handling the Esc command, the old key combinations such as Esc-E for ‘edit’ are no longer supported.
	 The ‘F1’ key defaults to Help/Contents.  In previous releases, F1 was the keystroke to enter a long command from the keyboard.  To enter long commands, use the ‘:’ (colon) key which by default performed this function in previous releases.
	Throughout the user interface, keystroke commands have been implemented to conform to Windows standard.  If there are keystroke commands for a feature/function in a pull-down menu, the keystroke is listed in the menu item:
	In the File menu, Ctrl+O is the keystroke combination to open a file.  Similarly Ctrl-N will start a new drawing.  Both are Windows standard keystrokes for these features.
	Mouse Button Assignments
	The applications default to the traditional mouse-button assignments although these can be changed according to your preferences in the User Preferences tab of the Tools/Options property sheet.  By default the button assignments are:
	 Left-mouse button – digitize points & cursor strokes.
	 Middle-mouse button – activate pop-up menus.
	 Right-mouse button – track the static icon area.
	In addition to these 3 standard mouse buttons, support has been added for the ‘Forward’ and ‘Back’ mouse buttons.  As with previous versions, the scroll wheel can be programmed also.  The default settings and other choices are set in the Tools/Options dialog on the User Preferences tab:
	The left-right tilt-wheel, while not programmable, is recognized by the software and by default will operate the horizontal scroll bar (scroll-left, scroll-right).
	In ExpertCAD 3D and ExpertCAD, default behavior is defined when the Ctrl or Shift key is held down while digitizing in the graphics area.  Ctrl will select (or unselect) the entity near the cursor (i.e. toggle the selected state).  Shift will select the entity near the cursor adding it to the collections of entities currently selected (i.e. add to selection).
	Scroll Bars
	Horizontal and vertical scroll bars for scrolling a drawing left/right, up/down are enabled by default in ExpertCAD.  The scroll bars function according to Windows standard.  If you wish reclaim some graphics area, the scroll bars can be disabled and hidden in the Tools/Options dialog.
	Drag & Drop Support
	Windows-standard drag & drop of files into the application window is supported.  In ExpertCAD and ExpertCAD 3D, if a file is currently being edited, the file is inserted into the drawing otherwise the file is opened and becomes the current file being edited.  In ExpertCAM, drag & drop functions the same as File/Open.  In all cases only 1 file can be specified and it must be of a file format that the application can read.
	Popup Menus
	Popup menus are Windows-style pull-right menus as opposed to the stacking-style in previous releases.  The title of the pull-right appears in the main menu with its contents in the pull-right.
	Pop-up menus are used for those features/functions that are dependent on the position of the cursor at the time the function is used.
	If preconditions for using an item in the menu are not met, the item is disabled.  In this example, there is no current text so the menu item Delete Current Text is disabled.
	All items in popup menus (graphics and textual menus) have 1-line help messages that are displayed in the status bar when that item is tracked.
	Many of the features implemented in popup menus in previous releases have migrated to the pull-down menus.  Operations that require pre-positioning of the cursor are implemented as popup menus.
	The ‘menustick’ (default menu item) feature is implemented in a Windows standard manner.  The default item is in bold text and can be invoked by choosing the text in the main menu.
	If you use the library feature, the modules you specify to use will be added to the main popup menu:
	In this example, the parametrics, mold components and user library are requested.
	To bring up the user interface for the library, choose its icon in the graphics popup menu.
	Note that there are 1-line help messages shown in the status bar when you track over an icon in any graphic popup menu.
	ExpertCAD 3D Popup Menus
	The Find Delete menu is a renamed version of the former FIN/DEL menu.  
	The same features and functions are provided with menu items that provide for greater clarity.
	The Point Edit menu is a renamed version of the former PT EDIT menu.
	The menu retains the same order and functionality as previous releases.  The menu items themselves have been modified for clarity as to their purpose.
	Menu items are disabled when pre-conditions don’t allow their use.  In the example to the left, we don’t have a current point so therefore the Drag functions for point selection are disabled.
	The Measure popup menu is functionally the same as in previous releases.  
	Remember that a 1-line help message is now available in the status bar when you track over an icon.
	The Snap Point To menu lets you choose whether to snap to objects in 3D space or constrain the snap to the current workplane.  
	A check mark is shown next to the snap mode currently in effect.
	ExpertCAD Popup Menus
	The Find Delete menu is a renamed version of the former FIN/DEL menu.  
	The same features and functions are provided with menu items that provide for greater clarity.
	Notice that menu items are disabled when conditions for the proper usage do not exist.
	The Point Edit menu is a renamed version of the former PT EDIT menu.
	The menu retains the same order and functionality as previous releases.  The menu items themselves have been modified for clarity as to their purpose.
	Note the menu item Filter by Class has a checkmark next to it.  This indicates that the Filter by Class is currently enabled.  Choosing this menu item will toggle its state on and off.
	Here again, menu items are disabled when pre-conditions don’t allow their use.  In the example to the left, we don’t have a current line enclosing any entities so therefore the Select Enclosed functions for point selection are disabled. 
	The Measure popup menu is functionally the same as in previous releases.  For clarity the icons have been revised in appearance and 1-line help is provided in the status bar when an icon is highlighted.
	Drawing Xtras is a replacement for the former DRAW popup menu.  Included in this menu are the features that modify the current line most of which are dependent on the cursor position.
	Dialogs
	Windows-style dialogs are used throughout the applications.  The former proprietary dialog look and feel has been discarded.  In addition to Windows-standard dialogs, specialized dialogs have been added for consistency where required:
	The Layer Manager dialog has been converted to a Windows dialog and reworked to make it easy to delete, rename or create new named layers because they work per Windows standard.  
	The Line Style dialog shows the true dash pattern and width of each line style available
	The Font dialog lists all fonts currently available and provides a preview of your selection.
	The color dialog shows all available color choices with one-click selection.
	Menus
	The menu set has been modified to conform closely to Windows standards and common practice for organization and function.  The menus themselves follow Windows standards for usage:
	The menus can be navigated using your mouse or the keyboard by using the Alt keystroke in combination with other keystrokes.  Underlined characters indicate the key to use to navigate to that item.
	If there is a keystroke (short command) associated with a menu item, it will be listed on the menu to right of the text for that item (e.g. the Del key will perform the same function as Edit/Delete).
	In all cases, menu items are disabled if the proper conditions do not exist to use that item.  In this example, Redo is disabled because we have not done an Undo yet.  Similarly Paste is disabled because there is nothing suitable on the clipboard to paste into ExpertCAD.
	When you track over a menu item, a 1-line help message will be shown in the status bar to describe its function.
	ExpertCAD 3D Menus
	New – start a new design.  This is the same function as the former File/Clear menu item.
	Open – edit a design.  This is the same function as the former File/Edit menu item.
	Insert – inserts design data into the current design.  This is the same function as the former File/Merge menu item.
	Save – save the current design.
	Save As - save the current design to a different file name.  Note that the file specified becomes the current edit file.
	Save Current Class – save only those drawing items in the current class to a file.  Same function as the former Save Class menu item.
	Export – output design data in an alternate format.  Options for exporting files can be set on the Import/Export tab of the Tools/Options property sheet. 
	AutoCAD DXF and DWG output is a new feature for 2009.  Both options respond to the 2D Drawing Export settings in the Import/Export tab of the Tools/Options dialog.
	Windows Bitmap produces a 24-bit image of the design in the current view as a .bmp file.
	Send To – forward the design data as e-mail or to SofTech’s Prospector application for NC machining:
	Note that the Mail option may not be compatible with e-mail programs other than Microsoft Outlook.
	Create Mold Drawing – this is the same feature as prior versions however the submenu contains the choices for output instead of posting a dialog.
	Page Setup – establishes the printer, paper size, orientation and margins you wish to use as a default for printing.
	Print – print all or part of the design.  Printing options including precise scaling can be specified on the Print/Plot tab in the Tools/Options property sheet.
	Plot – plot all or part of the drawing using the WinPlot HPGL/2 plotting application.
	Properties – displays the design properties dialog.  This replaces the Drawing Mgmt dialog in previous versions.
	Recent Files – lists the last 8 most recent files that were opened so you can quickly edit one of them by choosing it from this menu.
	Undo – reverses the effect of the last change to the design.  Up to 10 levels of undo/redo are supported.
	Redo – roll-forward the last operation that was undone.
	Cut – puts only the selected design entities on the system clipboard and removes them from the design.
	Copy – puts only the selected design entities on the system clipboard.
	Paste – inserts the contents of the clipboard at the current point and makes those entities selected.
	Select All – selects all design entities.
	Delete – deletes all selected design entities.
	Notes on Cut/Copy/Paste….
	When you use Cut or Copy, the selected entities are written to the system clipboard.  By default the data is written in a native 3D format, ExpertCAD format and as a Windows bitmap. This allows you to paste the items you selected into another session of ExpertCAD 3D as design entities.  This also means that you can Cut & Paste between ExpertCAD 3D and ExpertCAD.   Because a bitmap is placed on the clipboard, you can paste that into another application that supports bitmaps.  For example, you can use Edit/Paste in Microsoft Word to insert an image of what you copied in ExpertCAD 3D into a document.  
	When you use Edit/Paste in ExpertCAD 3D, it will choose to use the first available format in this order:
	1. ExpertCAD 3D native format.
	2. PDB format.
	3. ExpertCAD format.
	4. Text (places a text note into the design at the current point).
	When using Cut & Copy, the ExpertCAD and bitmap data is representative of the current view when the data is cut or copied.  
	In the File I/O tab of the Tools/Options dialog you can choose the formats you wish to place on the clipboard when Cut or Copy is used in ExpertCAD 3D.  
	Redraw – clears the graphics area and redraws.
	Zoom to Fit – fits the design to the current view.
	Zoom to Fit All – fits the design in all views.
	Zoom to Area – zooms into an area you indicate using the mouse.  
	Zoom In/Out – dynamic zoom in/out using the mouse.
	Zoom to Scale – set the view scale to a value you specify.
	Zoom by Factor – scale the view scale by a factor you specify.
	Pan – dynamically pan using the mouse.
	Previous View – return the previous view orientation.
	The Mold and Electrode design menus are unchanged in function.  Cosmetic changes and the enabling/disabling of menu items have been added.
	Tools is a new menu that consolidates various features that were formerly scattered throughout other menus in previous versions. 
	Screen Capture – using the mouse, indicate an area of the screen to capture as a bitmap and place on the system clipboard.
	Engineering Change - posts the engineering change dialog to perform a difference between 2 sets of design data.
	Layer Manager – posts the layer manager dialog to delete layer names, create new layer names or change layer names.
	Color Editor – posts the color editing dialog to change line colors and/or icon colors.
	Options – posts the Options property sheet to set preferences.
	Tools/Options Property Sheet
	The Options property sheet replaces the functions formerly found in dialogs posted from the SET-UP popup menu.  
	Clicking on a tab on the property sheet brings that dialog to the forefront for entering your preferences.
	Click OK to accept changes to all the dialogs.  Click Apply to accept changes to the current dialog.  The settings will be saved to your personal configuration file:
	C:\<Personal application data>\ SofTech\ToolDesigner\ExpertCAD3D-Setup.cfg
	Where <Personal application data> is typically:
	Windows 2000/XP - C:\Documents and Settings\<user>\Application Data
	Windows Vista - C:\Users\<user>\AppData\Roaming
	Never edit the file ExpertCAD3D-Setup.cfg.  This file is created and re-written by the Options dialog.  Any changes or edits you might make will be lost the next time you use the Options dialog to change a setting.
	The Draw menu replaces the former POINT and BUILD popup menu.  The same features and functions have been consolidated into this single menu:
	ExpertCAD Menus
	New – start a new drawing.  This is the same function as the former File/Clear menu item.
	Open – edit a drawing.  This is the same function as the former File/Edit menu item.
	Save – save the current drawing.
	Save As - save the current drawing to a different file name.  Note that the file specified becomes the current edit file.
	Save Current Class – save only those drawing items in the current class to a file.  Same function as the former Save Class menu item.
	Export – write the drawing to a file in your choice of formats:
	Options for exporting files can be set on the Import/Export tab of the Tools/Options property sheet. 
	HSF is a new option to output the drawing in Hoops Streaming Format.  This format can be read by popular viewing programs such as SolidWorks eDrawings.
	Windows Bitmap writes the drawing as a .bmp file full size according to the current screen resolution and at the color depth (32, 24, … bits per pixel).
	Send To – forward the drawing data as e-mail or to SofTech’s Prospector application for NC machining:
	Page Setup – establishes the printer, paper size, orientation and margins you wish to use as a default for printing.
	Print – print all or part of the drawing.  Printing options including precise scaling can be specified on the Print/Plot tab in the Tools/Options property sheet.
	Plot – plot all or part of the drawing using the WinPlot HPGL/2 plotting application.
	Properties – displays the drawing properties dialog.  This replaces the Drawing Mgmt dialog in previous versions.
	Recent Files – lists the last 8 most recent files that were opened so you can quickly edit one of them by choosing it from this menu.
	Undo – reverses the effect of the last change to the drawing.  Up to 10 levels of undo/redo are supported.
	Redo – roll-forward the last operation that was undone.
	Cut – puts only the selected drawing entities on the system clipboard and removes them from the drawing.
	Copy – puts only the selected drawing entities on the system clipboard.
	Paste – inserts the contents of the clipboard at the current point and makes those entities selected.
	Select All – selects all drawing entities.
	Delete – deletes all selected drawing entities.
	Notes on Cut/Copy/Paste….
	When you use Cut or Copy, the selected entities are written to the system clipboard in ExpertCAD format and as a Windows bitmap.  This allows you to paste the items you selected into another session of ExpertCAD as drawing entities or into another application that supports bitmaps.  For example, you can use Edit/Paste in Microsoft Word to insert an image of what you copied in ExpertCAD into a document.  The bitmap picture created by Cut/Copy is dependent on the zoom scale at the time you cut or copy the image.  If you need a smaller bitmap image, zoom out where zooming in will create a larger image.  It is not necessary for the selected entities to be visible in the graphics area for a complete image to be created.
	When you use Edit/Paste in ExpertCAD, it will choose to use native ExpertCAD data if it is available on the system clipboard.  If that format does not exist, it will choose to use a text format if that is available and insert the data as a text note.  This allows you to copy textual data from Microsoft Word or Excel into ExpertCAD.
	The View pull-down menu replaces the former popup View menu in previous releases.
	Redraw – clears the graphics area and redraws.
	Zoom to Fit – fits the drawing to the graphics area.
	Zoom to Area – zooms into an area you indicate using the mouse.  
	Zoom In/Out – dynamic zoom in/out using the mouse.
	Zoom to Scale – set the view scale to a value you specify.
	Zoom by Factor – scale the view scale by a factor you specify.
	Pan – dynamically pan using the mouse.
	Previous View – return the previous view orientation.
	Display Grid – show or disable a visible grid.
	Insert is a new menu that implements certain functions formerly found on the File menu.
	Drawing – inserts (merges) a drawing into the current drawing you are working on.  This is the same function as the former File/Merge… menu item.
	New Symbol – creates a symbol from an ExpertCAD file.
	Call to a Symbol – places a call to a symbol at the current point.  This is the same function as the former File/Call… menu item.
	Update Symbol Definition – updates the definition of a symbol from the contents of its original disk file.  This is the same function as the former File/Recall… menu item.
	Tools is a new menu that consolidates various features that were formerly scattered throughout other menus in previous versions. 
	Screen Capture – using the mouse, indicate an area of the screen to capture as a bitmap and place on the system clipboard.
	Engineering Change - posts the engineering change dialog to perform a difference between 2 drawings.
	Purge – rids the drawing data of unused and/or unwanted text buffers or dimension character definitions.
	Layer Manager – posts the layer manager dialog to delete layer names, create new layer names or change layer names.
	Color Editor – posts the color editing dialog to change line colors and/or icon colors.
	Options – posts the Options property sheet to set preferences.
	The Draw menu replaces the former POINT and BUILD popup menu.  The same features and functions have been consolidated into this single menu:
	The Draw Menu
	The Points Submenu
	The Splines Submenu
	Tools/Options Property Sheet
	The Options property sheet replaces the functions formerly found in dialogs posted from the SET-UP popup menu.  
	Clicking on a tab on the property sheet brings that dialog to the forefront for entering your preferences.
	Click OK to accept changes to all the dialogs.  Click Apply to accept changes to the current dialog.  The settings will be saved to your personal configuration file:
	C:\<Personal application data>\ SofTech\ExpertCAD\ExpertCAD-Setup.cfg
	Where <Personal application data> is typically:
	Windows 2000/XP - C:\Documents and Settings\<user>\Application Data
	Windows Vista - C:\Users\<user>\AppData\Roaming
	Never edit the file ExpertCAD-Setup.cfg.  This file is created and re-written by the Options dialog.  Any changes or edits you might make will be lost the next time you use the Options dialog to change a setting.
	Printing from Windows in ExpertCAD, ExpertCAD 3D and ExpertView
	The print feature has been completely redone to allow more flexibility and choices for output.  
	Page Setup has been added to the File menu to allow you to choose a default printer and set the characteristics for that printer.  The choices you make in the Page Setup dialog will be used as the default when you print although you will have the option to choose a different printer and settings when the print dialog is posted.  These settings are persistent and will be restored when you start future sessions of the application.  If you don’t use the Page Setup feature, the default settings will be those of the default printer set for your computer.
	In the Print/Plot dialog in the Tools/Options property sheet, you can choose to set the scale at which you want the drawing to be printed:
	The Fit drawing to paper switch is enabled by default.  This means the software will scale the output to fit the drawing to the paper size you have chosen taking into account the current margins.
	If you want to print at a specific scale, un-check the switch Fit drawing to paper then enter the scale at which to print the drawing.  In this example, we’re using 1.0 which means a full scale drawing.
	Regardless of whether you choose the Fit option or a specific scale, the scaling method aligns the center of your drawing with the center of the printable area of the page as specified by the paper size and margins.  The scale is applied relative to this center point.
	Line width replaces the function of the former “Line Width Factor” in previous releases.  Line width specifies how wide a 1 pixel wide (e.g. style 0) line on the screen should be drawn when printed.  The value specified is always in inch regardless of the system of units.
	In ExpertCAD 3D you can choose the view of the design you wish to print on this same dialog:
	The standard views as well as the orientation of the current view are the options available to you in the menu.  
	The ability to print multiple copies is supported provided your printer supports this feature.
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